Instructions for Use

**HVLab Thermal Aesthesiometer**

Human Factors Research Unit
Institute of Sound and Vibration Research
University of Southampton
Southampton S017 1BJ, UK

**HVLab document number TA 009**

<table>
<thead>
<tr>
<th>Issue</th>
<th>Date</th>
<th>DRF No</th>
<th>Description</th>
<th>Signature</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.0</td>
<td>03/08/04</td>
<td>009</td>
<td>First Issue</td>
<td>CHL</td>
</tr>
<tr>
<td>2.0</td>
<td>10/08/04</td>
<td>013</td>
<td>Addition of CE mark</td>
<td>CHL</td>
</tr>
<tr>
<td>3.0</td>
<td>16/01/06</td>
<td>032</td>
<td>Updated test instructions for v7 software</td>
<td>CHL</td>
</tr>
<tr>
<td>4.0</td>
<td>24/04/07</td>
<td>117</td>
<td>Addition of disposal information</td>
<td>CHL</td>
</tr>
<tr>
<td>5.0</td>
<td>03/09/07</td>
<td>162</td>
<td>Test and installation instructions updated for v8 software</td>
<td>SAS</td>
</tr>
<tr>
<td>5.1</td>
<td>26/05/09</td>
<td>244</td>
<td>Clarification to recommendation for intervals of regular calibration.</td>
<td>SAS</td>
</tr>
<tr>
<td>6.0</td>
<td>08/09/10</td>
<td>263</td>
<td>Updated technical specifications, figure for USB setup, system information, Annexe A and Annexe B. Removed Annexe C.</td>
<td>SAS</td>
</tr>
<tr>
<td>6.1</td>
<td>12/07/11</td>
<td>298</td>
<td>Updated WEEE symbol and CE declaration</td>
<td>SAS</td>
</tr>
<tr>
<td>6.2</td>
<td>15/05/12</td>
<td>319</td>
<td>Amended trouble shooting guide</td>
<td>YY</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td></td>
</tr>
<tr>
<td>6.3</td>
<td>17/12/14</td>
<td>346</td>
<td>Addition of Appendix C - Guidance and Manufacturer’s Declaration. EMC EN60601-1-2.</td>
<td>GP</td>
</tr>
</tbody>
</table>
Thermal Aesthesiometer

Instructions for Use
Table of Contents

1 SYSTEM INFORMATION.......................................................................................................................... 5

2 PRODUCT SPECIFICATION ................................................................................................................ 6

2.1 Technical Specifications.................................................................................................................. 6

3 INSTALLATION AND COMMISSIONING ............................................................................................ 8

3.1 System components....................................................................................................................... 8

3.2 Setting up the controlling computer and software ...................................................................... 9

3.3 Setting up the Thermal Aesthesiometer....................................................................................... 9

4 RUNNING A THERMOTACTILE PERCEPTION THRESHOLD TEST ............................................. 11

4.1 The Control Panel Window............................................................................................................. 11

4.1.1 Current Subject ....................................................................................................................... 11

4.1.2 Diagnostic Tests....................................................................................................................... 12

4.2 Thermotactile Threshold Test Window........................................................................................ 12

4.2.1 Subject Details ....................................................................................................................... 12

4.2.2 Test Parameters....................................................................................................................... 13

4.2.3 Test details............................................................................................................................... 15

4.2.4 Test Results............................................................................................................................. 16

4.2.5 Calibration............................................................................................................................... 16

4.3 The Thermotactile Threshold Measurement Window................................................................. 16

4.4 Viewing Previously Collected Test Results................................................................................ 21

4.5 Printing a Test Record.................................................................................................................. 21

4.6 Manually Entering Test Results.................................................................................................... 22

4.7 Editing Test Results....................................................................................................................... 22

4.7.1 Edit Results............................................................................................................................. 22

4.7.2 Edit Parameters....................................................................................................................... 22

4.7.3 Edit Notes and Tester.............................................................................................................. 23

4.7.4 Edit Data File Name................................................................................................................ 23

5 MAINTENANCE....................................................................................................................................... 24

5.1 Cleaning........................................................................................................................................ 24

5.2 Calibration..................................................................................................................................... 24

5.3 Regular performance checks by the user ...................................................................................... 24

6 WARNINGS AND PRECAUTIONS....................................................................................................... 26
6.1 Handling and Storage........................................................................................................... 26
6.2 Precautions and contra-indications.................................................................................... 26
6.3 Connection to external devices .......................................................................................... 26
6.4 Obtaining reliable measurements....................................................................................... 26
  6.4.1 Finger skin temperature ............................................................................................... 26
  6.4.2 Previous exposures to vibration .................................................................................. 26
  6.4.3 Previous exposure to extremes of temperature ......................................................... 26
  6.4.4 Auditory cues .............................................................................................................. 27
  6.4.5 Finger contact ............................................................................................................. 27
  6.4.6 Instructions to subjects ............................................................................................... 27
  6.4.7 Location of the applicator ........................................................................................... 27
  6.4.8 Length of test .............................................................................................................. 27

7 SPARES AND ANCILLARY SERVICES.............................................................................. 28

8 DISPOSAL............................................................................................................................ 29
  8.1 Information on Disposal for Users of Waste Electrical & Electronic Equipment (excluding private households) ........................................................................................................... 29
  8.2 Information on disposal in other countries outside the European Union ......................... 29

9 TROUBLESHOOTING GUIDE.......................................................................................... 30

10 CE DECLARATION OF CONFORMITY ........................................................................ 31

ANNEXE A INTERFACE OF THE USB-2527 COMPUTER INTERFACE................................. 1

ANNEXE B INSTALLING AND SETTING UP THE SOFTWARE.............................................. 1
  B.1 Software installation options .......................................................................................... 1
  B.2 Performing a new installation ....................................................................................... 1
  B.3 Performing an installation over a distributed network.................................................. 2

ANNEXE C: GUIDANCE AND MANUFACTURE’S DECLARATION........................................ 1
  C1. Guidance and manufacturer’s declaration – electromagnetic emissions ...................... 1
  C2. Guidance and manufacturer’s declaration – electromagnetic immunity ....................... 2
1 System Information

This manual was supplied with the following system:

Device: HVLab Thermal Aesthesiometer

Model Number: TA3.0

Manufacturer and Contact Details:

Human Factors Research Unit  
Institute of Sound and Vibration Research  
University of Southampton  
Highfield  
Southampton SO17 1BJ  
United Kingdom

Telephone: +44 (0)23 8059 2277  
Fax: +44 (0)23 8059 2927  
Email: hvlab@soton.ac.uk
2 Product Specification

The HVLab Thermal Aesthesiometer provides measurement of tactile perception thresholds for thermal stimuli (i.e. the minimum change in temperature which can be perceived) at various sites on the surface of the body. It may be used for the assessment of sensory changes associated with neurological dysfunction.

The applicator incorporates a Peltier semi-conductor head pump covered by a thin metal contact plate. The patient may rest a finger or toe on the contact plate, or it could be held against any part of the body.

Tests may be performed to determine warm and cool thresholds, starting from either a fixed reference temperature or the skin temperature of the patient. In-built safety cut-outs ensure that the safe working temperature range is not exceeded. The temperature probe allows for independent monitoring of another site, for example, room temperature or a second skin location.

During a thermotactile perception threshold test the Thermal Aesthesiometer is controlled by a personal computer. The temperature of the applicator contact plate is increased or decreased, until the patient depresses the response button. The temperature of the contact plate is then returned to the starting temperature. An automatic test programme repeats this process a pre-set number of times to establish threshold levels for perception of warmth and cool sensation.

2.1 Technical Specifications

<table>
<thead>
<tr>
<th>Skin-stimulator contact:</th>
<th>Circular aluminium plate</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contact plate diameter</td>
<td>55 mm</td>
</tr>
<tr>
<td>Maximum temperature range</td>
<td>5°C to 55°C</td>
</tr>
</tbody>
</table>

Stimulus:

| Contact plate reference temperature | Selectable in range 25°C/s to 40°C/s |
| Error in temperature setting | < 0.5°C at 30°C |
| Error in temperature setting | < 1.0°C at 15°C and 50°C |
| Error in temperature setting | < 1.5°C at 10°C |

| Rate of temperature decrement | Selectable in range 0.2°C/s to 2.5°C/s |
| Rate of temperature increment | Selectable in range 0.2°C/s to 2.5°C/s |
| Accuracy of rate of change of temperature | < 10% error in temperature change over 15 s at 1°C/s from 30°C to 45°C |
| | < 13.3% error in temperature change over 15 s at 1°C/s from 30°C to 15°C |
| Lower temperature limit | Selectable in range 5°C to 10°C |
| Upper temperature limit | Selectable in range 50°C to 55°C |
| Data sampling rate | 10 readings per second |

Psychophysical algorithm:

<table>
<thead>
<tr>
<th>Averaging method</th>
<th>Method of limits</th>
</tr>
</thead>
<tbody>
<tr>
<td>Consistency checks</td>
<td>Arithmetic mean of reversals</td>
</tr>
<tr>
<td>Number of reversals</td>
<td>Variability indicated by standard deviations</td>
</tr>
<tr>
<td>Number of reversals</td>
<td>4 to 15</td>
</tr>
<tr>
<td>Spec</td>
<td>Details</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>----------------------------------------------</td>
</tr>
<tr>
<td>Delay between reversals</td>
<td>0 to 5 s (with a random variation of up to ± 25%)</td>
</tr>
<tr>
<td>Neutral zone</td>
<td>Difference between hot thresholds and cold thresholds</td>
</tr>
<tr>
<td>Skin and room temperatures:</td>
<td>Measured by k-type thermocouple</td>
</tr>
<tr>
<td>Temperature measurement error</td>
<td>&lt; 0.5 °C in range 15 – 45 °C</td>
</tr>
<tr>
<td>Dimensions:</td>
<td></td>
</tr>
<tr>
<td>Applicator</td>
<td>Height 160 mm, diameter 100 mm (base),</td>
</tr>
<tr>
<td></td>
<td>diameter 55 mm (top), weight 0.8 kg</td>
</tr>
<tr>
<td>Control box</td>
<td>Height 100 mm, length 320 mm, width 470 mm,</td>
</tr>
<tr>
<td></td>
<td>weight 6.4 kg</td>
</tr>
<tr>
<td>Power Requirements:</td>
<td>220 to 250 V&lt;sub&gt;AC&lt;/sub&gt; 100VA</td>
</tr>
<tr>
<td>Options</td>
<td>110 to 120V&lt;sub&gt;AC&lt;/sub&gt;</td>
</tr>
<tr>
<td>Compliance with standards:</td>
<td>Complies with the following standards</td>
</tr>
<tr>
<td>ISO 60601-1:2006</td>
<td>Medical electrical equipment – Part 1: General requirements for basic safety and essential performance</td>
</tr>
</tbody>
</table>
3 Installation and commissioning

3.1 System components

If any of the following items are missing, please contact the manufacturer (the system components are illustrated in Figure 1).

(a) Control Box
(b) Applicator
(c) Subject Response Button

Figure 1 System components (see Section 3.1)
(d) K-type thermocouple
(e) Computer Interface Cable
(f) Power Supply Cable
(g) Additional Protective Earth cable
(h) USB-2527 Computer Interface
(i) USB cable

3.2 Setting up the controlling computer and software

The Thermal Aesthesiometer is controlled by the HVLab Diagnostic Instruments Manager software, running on a suitable personal computer. The computer should have the following minimum specification:

- Pentium processor (1.5 GHz or more)
- Microsoft Windows XP operating system
- Display resolution of at least 1024x768 pixels
- CD-ROM drive
- More than 100 MB free on drive C:
- One USB2.0 port (for connection of a USB-2527 interface board)

Follow the instructions in Annexe A of this manual for installing the interface board and in Annexe B for installing the Diagnostic Instruments Manager Software.

As well as controlling the Thermal Aesthesiometer Meter, the HVLab Diagnostic Instrument Manager provides database software with a simple interface for entry of patient details and health surveillance information, and for storing test results. The database has been designed to interact with the whole range of HVLab series of diagnostic instruments, allowing test results to be automatically added to the database. For further information on the database software see the HVLab Diagnostic Instruments Manager Database instructions for use.

3.3 Setting up the Thermal Aesthesiometer

Connect the applicator cable to the connector marked Applicator and the applicator thermocouple to the connector marked Applicator Thermocouple on the front of the control box.

Connect the subject response button cable to the connector marked Response Button on the front of the control box.

Connect the k-type thermocouple to the connector marked Free Probe Thermocouple on the front of the control box.

Connect the mains power cable between the power connector on the rear panel of the control box and a mains 220-240v AC supply.

Secure the spade connector on the additional protective earth cable to the green earth terminal on the rear panel of the control box. The other end of the protective earth cable is fitted with a mains plug that should be connected to an additional mains socket. Alternatively, the plug may be removed and the cable connected to a fixed and permanently installed Protective Earth Conductor. The additional protective earth should be connected at all times when the system is in use for testing patients or experimental subjects.
Connect the **Computer Interface Cables** to the connector marked **Equipment Interface** on the USB-2527 interface box.

Press the green button marked **power** on the front of the control box to switch on the Thermal Aesthesiometer. You should see the following:

- A green power light on the front of the control box
- An orange light on the front of the control box when the response button is pressed

The **Display** button on the front of the control box can be used to switch the applicator temperature display on and off.

Your **HVLab** Thermal Aesthesiometer is now ready for use. Please refer to the troubleshooting guide if necessary.
4 Running a thermotactile perception threshold test

Thermotactile threshold measurements are controlled from the HVLab Diagnostic Instruments Manager software. The Diagnostic Instruments Manager programme integrates the software that controls the Thermal Aesthesiometer, and other HVLab diagnostic instruments, with a relational database of subjects/patients and test results. Please read the HVLab Diagnostic Instruments Manager Database Instructions for Use before proceeding.

When you start the HVLab Diagnostic Instruments Manager software the Control Panel window opens as shown in Figure 2. This window is divided into three main sections – Current Subject, which shows the currently active record in the subject or patient database; Diagnostic Tests, which provides access to the individual tests and databases of test results; and Questionnaires, which launches a health surveillance questionnaire database, if this has been provided.

4.1 The Control Panel Window

![Control Panel window]

Figure 2 Control Panel window

4.1.1 Current Subject

Before running a test it is necessary to enter the details of your test subject or patient into the database by clicking on Add New Subject to open the Subject Details window (Figure 3) and filling in the fields as appropriate. If the subject has already been entered into the database, locate the subject record using the navigation buttons in the lower left corner of the Control Panel window, or click on Find Subject in the Current Subject section.
4.1.2 Diagnostic Tests

The controls in the Diagnostic Tests section allow you to launch a new test, or to retrieve the results of existing tests from the test results database.

After entering or finding your subject or patient, select **Thermotactile Thresholds** in the **Test** list box. Click on **Start New Test** to open the Thermotactile Threshold Test window as shown in Figure 4. To retrieve the results of existing tests on the current subject, select **Thermotactile Thresholds** and click on **View Test Results**.

4.2 Thermotactile Threshold Test Window

The Thermotactile Threshold Test Window is divided into four sections – Subject Details, Test Parameters, Test Details and Test Results.

4.2.1 Subject Details

The Subject Details section (see Figure 4) shows the details of the current subject, which cannot be edited here. The new test record that will be created in the thermotactile test results database will be linked to this subject record.
4.2.2 Test Parameters

The Test Parameters section shows parameters of the thermotactile measurements that will be performed in the current test. The Measurement Sites are shown in the Test Results section. These parameters may be altered from the default values by selecting different parameter sets using the Parameter Set Name list box. Additional parameter sets may be entered into the database and existing parameter sets may be altered or deleted by clicking the Add New or the Edit/Delete controls (see section 4.2.2.10). The Test Parameters section includes the following values:

4.2.2.1 Parameter Set Name

The name of the current parameter set.

4.2.2.2 Number of Measurements

The number of test measurements to be completed. A measurement refers to the threshold determined at one test site with either a hot test or a cold test or both. The default value is the maximum of 8 measurements.
4.2.2.3 Reference Temperature

The reference temperature may be varied from 25°C to 40°C in 0.5°C steps. The default value is set at 32.5°C.

4.2.2.4 Temperature Increment Rate

The incremental rate refers to the rate at which the temperature of the applicator contact plate approaches the threshold value. For a hot test, this is the rate at which the temperature increases and for a cold test it is the rate at which the temperature decreases.

The rates of temperature increment rate may be varied from 0.2°C/s to 2.5°C/s in steps of 0.1°C/s. The default value is set at 1°C/s.

If the increment rate is too fast, there is a risk of the recorded thresholds being too high for a hot test or too low for a cold test. This is a result of subject reaction time in responding to the sensation. Incorrect thresholds may also be recorded if the rate is too slow because human temperature receptors adapt to slowly changing temperatures.

4.2.2.5 Temperature Decrement rate

The decrement rate is the rate of return to the reference temperature following a press of the subject response button. For a hot test, this is the rate at which the temperature decreases and for a cold test it is the rate at which the temperature increases.

The rates of temperature decrement rate may be varied from 0.2°C/s to 2.5°C/s in steps of 0.1°C/s. The default value is set at 1°C/s.

4.2.2.6 Number of reversals

The number of reversals may be varied from 4 to 15. The default value is set at 6. Too many repeats especially those at slow rates with long delays may result in subject boredom, loss of concentration and fatigue.

4.2.2.7 Delay between reversals

The delay between reversals can be set between 0 to 5 seconds. The default is set at 3 seconds. A random element of ± 25% is added to the chosen delay to reduce the chance of the subject anticipating the change of temperature, i.e. if the software delay is set to 4s, the actual delay will be varied randomly between 3s and 5s (4s ± 25%). By holding the applicator contact plate at a constant temperature between reversals, the temperature of the skin at the test site is stabilised. The length of the delay affects the total time required to complete a test; too short a delay will not allow for the stabilisation of skin temperature and too long a delay may result in subject boredom, loss of concentration and fatigue.

4.2.2.8 Temperature limits

The minimum and maximum temperature that the applicator will reach before cutting out are displayed here. The upper temperature limit can be set between 50°C and 55°C and the lower temperature limit can be set between 5°C and 10°C. The default values are set at 55°C and 10°C for the upper and lower limits respectively.

4.2.2.9 Record Free Probe

This function allows you to record the temperature of the free probe during the threshold measurement. For example, you may wish to have a record of the room temperature during the test.
4.2.2.10 Editing and creating new test parameters

To create a new set of test parameters, click Add New to open the Thermotactile Threshold Test Parameters window (Figure 5). This contains three sections: Parameter Set, General Settings and Settings for Individual Measurements.

![Thermotactile Threshold Test Parameters window](image)

**Figure 5** Thermotactile Threshold Test Parameters window

To define a unique parameter set, alter the values as appropriate within the General Settings section. The Settings for Individual Measurements section allows you to define test sites for each of the measurements. Once you have finished defining your parameters, label the parameter set in the Parameter Set Name field and click Save.

To edit the parameters in the currently selected Parameter Set, click on Edit/Delete in the Thermotactile Threshold Test window. Change the desired parameter and then click Save.

It should be noted that any alterations to the test parameters may affect the thermotactile thresholds obtained.

You can also edit the test parameters for Measurement Site while carrying out a test by going to the Edit menu located on the menu bar and selecting Edit Parameters. However, this will only change the parameters for that particular test.

4.2.3 Test details

The Test Details section (Figure 4) includes values for Room Temperature and Finger Skin Temperature (left hand and right hand). These should be entered before the test results are finally saved: a warning will be given by the software if values have not been entered. The values can be entered manually or will be entered automatically from a previous test.

The TA Serial No. field displays the serial number of the Thermal Aesthesiometer which is currently connected to the computer. You can enter the serial number of the equipment in the Database Components window by selecting the Edit Components from the File menu located on the menu bar at the top left-hand corner of the Control Panel window. Then, scroll
down the window until you see the **Available Tests and Health Surveillance Questionnaires** table and enter the serial numbers of each instrument connected to your computer in the **Serial No.** column (see *HVLab* Diagnostic Instruments Manager Software User Manual for further details).

The **Tester** field identifies the person that performed the test (this defaults to the name of the user who is currently logged in to the database programme). The **Data File** field is used by the software to store the location of the data file which contains the thermograms (see section 4.3) of the individual threshold measurements.

Check **Run as a simulation** if you wish to run a simulated test without a subject (for demonstration).

### 4.2.4 Test Results

This section contains the hot and cold thermotactile thresholds, standard deviations and neutral zones for each of the test sites using the current defined parameters. The controls in this section allow you to start and repeat thermotactile threshold measurements.

Click one of the **Start** buttons to launch a thermotactile threshold measurement. The fields to the left of each button show the test site to which the applicator should be applied. Clicking **Start** opens the **Thermotactile Threshold Measurement** window (Figure 6) where you can perform the individual threshold measurement and save the **thermotactile thresholds** and **standard deviations** back to the database. Please read section 4.3 for instructions on how to perform a thermotactile threshold measurement.

When all the measurements have been completed, click **Save and Exit** in the bottom left corner of the window to save the test record to the database and return to the **Control Panel** window. Alternatively, clicking **Cancel** will return to the **Control Panel** window without saving the test results.

### 4.2.5 Calibration

The **Calibration button** opens the **Calibration window**. This window provides a means for monitoring temperature during calibration procedures. Please read section 5.3.

### 4.3 The Thermotactile Threshold Measurement Window

Clicking on **Start** opens the **Thermotactile Threshold Measurement** window. At the top of the screen are the buttons to **Start**, **Stop**, **Cancel** or **Save**. The name, reference number of the current subject and the date and time of test are also displayed. At the bottom of the screen are the **Site**, number of **Reversals**, **Reference** temperature (°C) and **Status** of the current measurement (Figure 6). This window which displays results of the thermotactile threshold measurements is also called a thermogram.
The experimental subject or patient should be given clear instructions concerning the experimental procedure before the first measurement is performed. Table 1 describes the procedure for measuring thermotactile thresholds at the fingertip. Precautions that should be taken to ensure reliable measurements are outlined in Section 6.4 of this manual.

Table 1. Instructions for experimental subjects or patients when measuring thermal thresholds at the fingers

(a) Rest your finger on the top of the applicator so that the fleshiest part of your finger-tip is in the centre of the contact plate.

(b) Make sure that during the test procedure you maintain contact with the applicator contact pad without exerting excessive pressure.

(c) Hold the response button in the opposite hand with the thumb over the button.

(d) When you perceive a change in temperature of the contact pad, press the response button and then release it; the temperature will return to its original level.

(e) When you perceive another change in temperature, press the response button again. This cycle will repeat until the experimenter tells you the test is complete.
Click **Start** to commence the threshold measurement. The test can be interrupted at any time by clicking **Stop**. Clicking **Cancel** will be return to the **Thermotactile Threshold Test** window and any data will be lost.

The thermogram is displayed in real time as the response button is pressed and released. Once the measurement is complete, the mean threshold and standard deviation is displayed in the thermogram (Figure 7). If you click **Stop** during the measurement, the mean threshold calculated will be the mean of the reversals which have been performed.

If the hot and cold threshold test has been performed on one finger both thresholds will be presented on one thermogram (figure 8). Click **Restart** to if you need to repeat the current threshold measurement. This must be done before the data is saved and the user returns to the **Thermotactile Threshold Test** window. To repeat a test, ensure that the appropriate measurement (either **Hot Threshold** or **Cold Threshold**) is selected under **Next Measurement** at the top of the **Thermotactile Threshold Measurement** window and click **Start**. This may be done as often as required.

**Figure 7** Results of a Hot Thermotactile Threshold Measurement
If the subject does not feel a change in temperature, either the **Upper Temperature Limit Exceeded** or the **Below Lower Temperature Limit** will appear. For safety purposes the temperature of the applicator will continue to return to the reference temperature without any button presses. The operator can decide if they would like to **Accept** the threshold (at 55ºC or 10ºC) as part of the results, **Reject** the threshold judgement (which means that this judgement is not used as part of the results) or **Stop** the test completely.

Click **Save** to return to the **Thermotactile Threshold Test** window. The thresholds and standard deviations will be transferred automatically to the database and displayed in the relevant fields. You will be prompted to save the complete thermogram as a `.TAD` file: the software will automatically suggest a filename (using the reference number and date) in the Data folder, but you may choose a different filename and/or location (Figure 9).
The test results will be transferred automatically to the database and displayed in the relevant fields. The **Running Test and Importing Results** dialogue is shown while the results are being transferred. This process can take several seconds.

![Figure 9 Dialogue for saving thermogram data file](image)

**Figure 9** Dialogue for saving thermogram data file

![Figure 10 Waiting for data transfer](image)

**Figure 10** Waiting for data transfer
If this dialogue fails to close because there was a failure in data transfer or because you cancelled a test, you will need to close the dialogue by selecting Cancel Import from the File menu on the top left-hand corner.

4.4 Viewing Previously Collected Test Results

To view the results for a particular subject, ensure that the correct subject is displayed in the Current Subject section of the Control Panel window. Select Thermotactile Thresholds from the drop down list in the Diagnostic Tests box and then click on View Test Results to display the Thermotactile Threshold Test window. This is the same window that was used to launch the measurements, except that the Start buttons for each measurement are now replaced by View buttons. If there are more than one test records for the current subject, you can use the navigation buttons in the bottom left corner of the screen to scroll to the required record set.

Click each View button to display the individual thermograms, which are saved in the Data File shown in the Test Details section. Alternatively, click View All to display a combined thermogram for the current test record. It is important that the location saved in Data File matches the location of the .TAD data file on your PC. If it does not, a browse dialogue will allow you to browse for the data file. Alternatively, you can edit the Data File location (see section 4.7).

The thermogram can be printed (to the default printer on your computer) or exported as a bitmap by selecting Print Graph or Export Graph from the File Menu. The scaling of the thermogram graph (i.e. the x- and y-axis limits) may be adjusted by selecting Rescale Graph from the View menu. This replaces the status fields at the bottom of the window by text controls showing the current axis limits which can be incremented or decremented by clicking on the associated scroll buttons.

The thermogram data, reversal points and calculated thresholds may also be exported to a CSV file by selecting Export Results from the File Menu.

Click Cancel to return to the Thermotactile Thresholds Test window.

4.5 Printing a Test Record

A test report of the test record can also be previewed and printed (Figure 11) from the Thermotactile Threshold Test window by clicking the Print Record button at the bottom of the window. The test report can look different for different versions of the software.

The software compares the results of the thermotactile threshold test, the vibrotactile threshold test, the finger rewarming test and the finger systolic blood pressure test to normal values as according to the ‘Standard diagnostic methods for assessing components of hand-arm vibration syndrome’ guidelines published by the Health and Safety Executive UK. You can access this table of normal values at any time by selecting View Normal Values from the View menu located on the menu bar at the top left-hand corner of the Control Panel window.

You can select the measurement which you would require for diagnostic comparison by checking the Print boxes next to the hot or cold threshold test of the individual measurement sites in Thermotactile Threshold Test window. This enables you to select the appropriate threshold measurements which you will use for diagnostic comparison if you have performed and recorded repeats.

It is recommended that these Print boxes are checked while conducting the test or before saving a test for ease of reference if you decide to print at a much later point in time. The boxes which were selected will be saved into the test record as well.
4.6 Manually Entering Test Results

To manually enter test data for the current subject, select the required **Diagnostic Test** and click **Manual Data Entry**.

Enter your test data in the respective boxes and click **Save and Exit** when you have finished.

4.7 Editing Test Results

If you wish to modify the test results in any test record, you can do so using the following commands from the **Edit** menu located on the menu bar - **Edit Results, Edit Parameters, Edit Notes and Tester** and **Edit Data File Name**. Use these functions only when necessary.

4.7.1 **Edit Results**

This command allows you to edit any of the test results in the current test record. You may use this command if you have accidentally entered the wrong test results into the database during manual data entry.

4.7.2 **Edit Parameters**

This command allows you to edit the test parameters and measurement sites in the current test record. You may use this command if you have accidently entered the wrong test parameters or measurement sites into the database during manual data entry.
4.7.3 **Edit Notes and Tester**

This command allows you to edit the notes section and the name of the tester. You may use this command if you wish to add more comments to the notes section in any test record or have accidentally entered the wrong comments and name of the tester into the database during manual data entry.

4.7.4 **Edit Data File Name**

This command allows you to edit the location of the file where the data has been saved into. You may use this command if you have accidentally entered the wrong location of the data file during manual data entry or if you would like to update the location of a data file, which has been moved to another location on your PC, in any test record.

When you have completed editing click **Close** to save the changes.
5 Maintenance

5.1 Cleaning

The subject response button and the applicator plate should be cleaned with an anti-bacterial wipe between each patient or subject.

Periodic cleaning and disinfecting of the TA and accessories

The TA, applicator, response button, cables, power supply or USB interface must NOT be immersed in water or other liquids. Do NOT use solvents or abrasive cleaners.

Cleansers and disinfectants must be CE marked indicating an intended purpose of medical devices & specified for use on metal and plastic.

Before cleaning, disconnect the power supply from the mains electrical supply, and disconnect the USB interface from the controlling computer.

Wipe using a cloth dampened with water and detergent which is indicated for use on plastic and metal parts. Apply the liquid to the cloth and squeeze out surplus liquid. Do not apply liquid to the device, and make sure that any liquid does not penetrate the sockets or other apertures.

Disinfect using a cloth dampened with disinfectant which is indicated for use on plastic and metal parts and is diluted as per the manufacturer's instructions. Apply the liquid to the cloth and squeeze out surplus liquid. Do not apply liquid to the device, and make sure that any liquid does not penetrate the sockets or other apertures. Wipe dry after disinfecting with a clean dry cloth.

Alcohol lens wipes may be used to clean the panel displays.

Ensure that all surfaces are dry before reconnecting to the electricity supply and computer.

5.2 Calibration

All HVLab Diagnostic Instruments are calibrated and quality controlled prior to delivery. A full calibration report is attached to this manual as Annexe 1.

The system is recommended to be re-calibrated at 12-monthly intervals and also if the equipment is moved to a new site. It is recommended that the calibration procedures are carried out by the manufacturer, or by a suitably trained person. Additionally, regular performance checks should be carried out by the user, as described in Section 5.3.

The manufacturer bears no liability for injury to any person resulting from removal of equipment casings. The manufacturer does not guarantee that calibrations carried out by any person other than one designated by the manufacturer will result in satisfactory performance of the system.

5.3 Regular performance checks by the user

The calibration of the two thermocouples are checked and adjusted during manufacture. However, periodic calibration checks are advisable.

To do this, first disconnect the applicator and then connect free probe thermocouples to both the ‘Applicator Thermocouple’ and ‘Free Probe Thermocouple’ sockets. Open the calibration screen in the software (‘Test’ menu). Place the thermocouples in a temperature controlled water bath (30-35°C) with a mercury-in-glass thermometer which is accurate to 0.1°C. With the water being constantly stirred and the thermocouples not touching the side of the bath, the screen should show the same temperature for the thermocouples as is given by the
thermometer. If the differences between the two are more than ±0.5°C, please contact the manufacturer.
6   Warnings and Precautions

6.1 Handling and Storage

When not in use, the Thermal Aesthesiometer should be switched off using the power button on the front of the control box. This will also remove power to the applicator.

Care should be given to the handling of the thermal aesthesiometer at all times, particularly the applicator. Dropping the applicator, even a short distance, may damage the applicator. If the applicator is dropped, proceed through calibration checks before the Thermal Aesthesiometer is used (see section 5).

The Thermal Aesthesiometer (TA) can be left connected to the computer whilst not in use.

6.2 Precautions and contra-indications

Please ensure that before the Thermal Aesthesiometer is used on patients:

The TA is calibrated to the required standard and is functioning correctly (see section 5)

There is no obvious damage to the device

The additional protective earth terminal is connected to earth via a mains power socket, or a permanently connected protective earth conductor.

6.3 Connection to external devices

It is possible to connect external accelerometers or signal conditioning equipment to the HVLab Thermal Aesthesiometer. Any equipment not supplied by the manufacturer above, and connected to the device must satisfy the following criteria:

conform with or maintain the requirements of medical electrical devices according to ISO 60601-1 and any applicable part 2

be a type B device

The manufacturer can not be responsible for any damage or injury sustained for external devices failing to meet these criteria.

6.4 Obtaining reliable measurements

In order to obtain repeatable measurements of thermotactile thresholds, attention should be given to various factors, these include:

6.4.1 Finger skin temperature

Finger skin temperatures at the measurement locations should not be below 22° C. If the reference temperature is not to be set to the skin temperature, it is advisable to maintain a contact between the applicator and the test site for a fixed period before testing so that the skin may adapt to the reference temperature.

6.4.2 Previous exposures to vibration

Exposure to vibration immediately prior to measurement of thermotactile thresholds might result in a temporary threshold shift. Any temporary threshold shift should be allowed to recover before measurement of thermotactile thresholds.

6.4.3 Previous exposure to extremes of temperature

The subject should be allowed to acclimatise to the temperature of the room for a suitable amount of time before testing to ensure thermal equilibrium.
6.4.4 Auditory cues

Noises in and around the testing location during measurements may be distracting. Precautions should be taken to ensure that the subject is not unnecessarily disturbed during testing. Suitable precautionary measures include the use of ear defenders, ear plugs or masking tones for the duration of each measurement.

6.4.5 Finger contact

For measurements on the finger, it is recommended that thresholds be obtained for the volar surface of the distal phalanx of the fingers with the centre of the whorl in contact with the applicator. The finger should be located in the centre of the applicator.

6.4.6 Instructions to subjects

All subjects should be given a set of written instructions. This is done to ensure that nothing is omitted when preparing the subject for the test and that the psychophysical response is not affected by giving subjects differing instructions. Table 1 (see section 4.3) shows a sample set of instructions which may be copied for use in combination with the Thermal Aesthesiometer.

6.4.7 Location of the applicator

Position the applicator unit on a firm, level surface that is isolated from the surface supporting the controlling computer (which contains cooling fans) or any other sources of vibration. It is desirable to use an arm rest to avoid fatigue of the arm or finger as this can lead to temporary threshold shift.

6.4.8 Length of test

Long test durations resulting from inappropriate selection of test parameters can induce subject fatigue and unreliable threshold measurements. To prevent a measurement becoming excessively long, a single threshold test has been limited to a duration of 10 minutes. The threshold is calculated from reversals completed within the allotted time.
7  Spares and ancillary services

The following accessories are available from the manufacturer. Please refer to the contact details at the beginning of this guide. If you wish to replace or have spares of a specific component, please contact us and we will endeavour to help you.

Subject Response Button

K-type Thermocouple

Distribution Box to allow a complete suite of HVLab instruments to be controlled by a single computer and interface board

We can also provide training, calibration and auditing of the operation of all diagnostic instruments. Please contact the manufacturer for a quotation.
8 Disposal

8.1 Information on Disposal for Users of Waste Electrical & Electronic Equipment (excluding private households)

Used electrical and electronic products must not be mixed with general waste.

Disposing of this product correctly will save valuable resources and prevent any potential negative effects on human health and the environment which could otherwise arise from inappropriate waste handling if you are unsure of your national requirements with respect to disposal. Please contact your local authority, dealer or supplier for further information.

Penalties may be applicable for incorrect disposal of this waste, in accordance with national legislation.

The above information is based on the European waste electrical and electronic equipment directive 2002/96/EC.

8.2 Information on disposal in other countries outside the European Union

This information is only valid in the European Union. If you wish to discard this product, please contact your local authorities or dealer and ask for the correct method of disposal.
## 9 Troubleshooting guide

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>No Power</td>
<td>The AC power lead has become disconnected from the control box. There is no mains power supply to the control box.</td>
<td>Check that the AC power lead is connected to the control box and that the power supply is connected to the mains.</td>
</tr>
<tr>
<td>Pressing the subject response button does not reduce the vibration</td>
<td>The response button is not connected.</td>
<td>Check that the response button is connected to the front of the control box.</td>
</tr>
<tr>
<td></td>
<td>The response button is faulty.</td>
<td>Check that the LED labelled ‘Response’ lights when the button is depressed.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Contact manufacturer if no light is seen, although button is connected.</td>
</tr>
<tr>
<td>Temperature display does not show any numbers</td>
<td>K-type thermocouple is not connected.</td>
<td>Check that you have connected a k-type thermocouple to the front of the control box.</td>
</tr>
<tr>
<td></td>
<td>K-type thermocouple is faulty.</td>
<td>Replace with a spare thermocouple if necessary.</td>
</tr>
<tr>
<td>The thermal aesthesiometer shows a low reference temperature</td>
<td>The thermal aesthesiometer has not been reset.</td>
<td>Press the reset button on the front of the control box.</td>
</tr>
<tr>
<td>I get a message saying “A to D interface card not found”</td>
<td>The settings are incorrect on the USB-2527 computer interface.</td>
<td>Ensure that the board is set to 16 single ended within the INSTACAL software.</td>
</tr>
</tbody>
</table>

If any of the above suggestions do not solve your problem, please contact the manufacturer by telephone on +44 (0) 2380 592277.
10  CE Declaration of Conformity

Declaration of Conformity to the Medical Device Directive 93/42 EEC as amended 2007/47/EC for HVLab Diagnostic Instruments

Comprising:
- Vibrotactile Perception Meter
- Thermal Aesthesiometer
- Multi-Channel Plethysmograph
- 8-Channel Temperature Monitor

each incorporating an HVLab Computer Interface

This is to certify that the class IIa equipment specified above conforms to the above Directives as transposed into national regulations and statutes of the United Kingdom, such compliance having been demonstrated via:

- A Technical File compliant to Annex VII
- Compliance to the Essential Requirements as per Annex I
- Quality Assurance procedures in accordance with BS EN ISO13485
- Compliance to Annex VI Product Quality Assurance

The CE marking of product being subject to the achievement and maintenance of a Annex VI certification by British Standards Institution Notified Body Number 0086 located at Kitemark Court, Davy Avenue, Milton Keynes, MK1 9EP, UK.

The devices do not include animal or human tissue or derivatives, blood products, products that would be considered to be medicinal products or phthalates as defined in annex I clause 7.5 nor are such materials used during their manufacture.

This is to certify that the above statement is true and relates to product manufactured from this date.

Signed: [Signature]

Name: Professor M J Griffin
Position: Management Representative
Date: 12th July 2011

for and on behalf of the Human Factors Research Unit, being a duly authorised officer of the company.

Human Factors Research Unit
Institute of Sound and Vibration Research, University of Southampton, Highfield Campus, Southampton
SO17 1BJ United Kingdom
Tel: +44 (0)23 8059 2277 Fax: +44 (0)23 8099 2927 www.isvr.soton.ac.uk

Document no. TA 015
Issue 3.0
HVLab Thermal Aesthesiometer
CE Declaration

12/07/11
Annexe A  Interface of the USB-2527 computer interface

A PC which is to be connected to one or more HVLab Diagnostic Instruments must first be installed with a USB-2527 computer interface board according to the instructions below.

(i) Put the Measurement Computing CD supplied with the USB-2527 interface into your CD-ROM drive. The installation process should start automatically. Uncheck all boxes (TracerDaq, DirectX, Hardware Manuals and Microsoft .NET framework) except InstaCal and Universal Library. Follow through the installation. Click Yes when you are prompted to restart your computer.

(ii) Connect the USB-2527 to a USB2 port on your computer. Do Not connect the USB-2527 until the InstaCal software has been successfully installed.

(iii) When you first connect the USB-2527, Windows will launch the ‘Found New Hardware Wizard’. Select No, not this time when asked if you want to “connect to Windows Update to search for software” and click on Next. Then click on Install the software automatically when Windows detects the MCC USB2 Loader Device.

(iv) After clicking Finish, Windows will again launch the ‘Found New Hardware Wizard’. Select No, not this time when asked if you want to “connect to Windows Update to search for software” and click on Next. Then click on Install the software automatically when Windows detects the USB-2527. After installing the USB-2527, click Yes when Windows prompts you to restart your computer.

(v) After installing the USB-2527, run the InstaCal programme by clicking on the shortcut in Start\Programs\MeasurementComputing (it is recommended that the InstaCal shortcut be copied to the desktop for easy access) to configure and self-calibrate the analogue inputs and outputs. InstaCal should automatically detect and list the USB-2527 on the USB bus. Make sure that USB-2527 is checked and click OK to continue. To work with HVLab software the USB-2527 board number must be designated as Board#0 (i.e. board zero). If you find that another board (e.g. a Demo Board) is currently board zero, then right-click on this board and select Remove Board to delete it. Right-click on the USB-2527, select Change Board# and select board zero.

(vi) Make sure your USB-2527 is configured for 16 Single Ended analogue input channels. Click on the USB-2527 to highlight it, then right-click on this and select Configure. Check that No. of Channels = “16 Single Ended”.

(vii) After installing and configuring your USB-2527 interface, you will need to calibrate the analogue inputs. Make sure nothing else is connected to your board during the calibration. Click on your USB-2527 to highlight it, then click on A/D button to self-calibrate the analogue inputs. Click on Calibrate and then OK when calibration is complete. This procedure should not need to be repeated unless the board is replaced or moved. The USB-2527 is now ready to be used.

(viii) The USB-2527 should always be connected to the same port that it was installed to. If it is moved to another USB port on the same computer the Instacal and HVLab software will not be able to find the interface unless it is re-installed and re-configured. You will need to follow steps 3 to 7 to reinstall the interface again.
Annexe B Installing and setting up the software

B.1 Software installation options

Before performing the installation of the software, decide whether you want to perform:

- A **new** installation – this would mean that the PC has never been installed with the HVLab Diagnostic Instruments Manager software. This is explained in Section B.2.
- An installation on a **distributed network** – this means that you would be able to perform different tests and view the test results with the same database using separate computers which work over a network. This is explained in Section B.3.

B.2 Performing a new installation

(i) The **USB-2527** interface supplied with your system should be installed before the HVLab software (please refer to Annex A Interface board installation).

(ii) The HVLab Diagnostic Instruments Manager stores test and questionnaire data in a MS ACCESS database. MS ACCESS 2003 can be installed on your computer, but it is not needed to run the HVLab software. However, all earlier versions of MS ACCESS are not compatible with HVLab and must be removed.

(iii) Some computers with P4 processors are capable of “**HyperThreading Technology**”. HyperThreading is not compatible with HVLab software and must be disabled in the computer’s BIOS setup program.

(iv) Close any Windows programs that are running.

(v) Put the installation CD into your CD-ROM drive (Assumed to be drive D:).

   *Note: If your CD-ROM drive is not drive D: or if you are installing from a network drive, then replace D: in the following with the drive letter corresponding to your installation drive.*

(vi) If the installation process does not start automatically, select ‘**Run**’ from the Microsoft Start Menu. This will open the Run dialogue window. Enter `D:\Setup.exe` then click on OK.

(vii) Follow through the installation. When choosing the setup type, it is recommended that you choose a ‘**Typical**’ installation. By default, the software will be installed into `C:\My Documents\HVLwin84` for version 8.4. Choose a ‘**Custom**’ installation if you want to install HVLab into a different directory. After clicking **Finish**, the HVLab Diagnostic Instruments Manager is ready to be used.

(viii) To be able to access the HELP documents from the HVLab software you will need to install Acrobat Reader (version 6.0 or above) on your computer. If you do not already have it, you can install Acrobat Reader from the CD by running `D:\Acrobat Reader\AdbeRdr910_en_US_Std.exe` from the Run dialogue or using Windows Explorer.

(ix) Start the HVLab software by selecting **HVLab diagnostic instruments** from the **Start/Programs** menu or by clicking on the **HVLab diagnostic instruments** icon on the desktop.

(x) When the software is launched for the first time, Windows may display a security warning asking if you want to block unsafe expressions: you should always click on **Yes**. You may then be asked to restart the application.
(xi) Windows may then display another security warning stating “This file has been digitally signed by HVLab ... This publisher has not been authenticated ...”. To prevent recurrences of this warning you should install a digital certificate by clicking on Details. Click on View Certificate in the Digital Signature Details dialogue, then on Install Certificate in the Certificate Information dialogue. This will launch the Certificate Import Wizard. Accept all the default options and click Yes to confirm that you want to “...install the certificate from a certification authority claiming to represent HVLab”. Close the Digital Signature Details dialogue and the Certificate Information dialogue so as to return to the original security warning.

(xii) At this point, you might or might not have the option to check the box for ‘Always trust files from this publisher...’. If you do have the option, check the box and click on Open to launch the HVLab software. If you don't have the option, then you will have this option when you launch the HVLab software the second time. If you do not check the box, then Windows will always prompt you every time you launch the software.

(xiii) You will be required to enter a valid User ID and Password: the default Personal ID is “admin” with Password “hvlab”. Additional users can be added or deleted after the software has been successfully set up (see HVLab Diagnostic Instruments Manager Database User Manual for further details).

(xiv) Click on Continue. The first time that the software is run, the location of all the software components will be automatically detected and displayed in the Database Components window. The default location for all the components is in (InstallPath) and (InstallPath)\Data where (InstallPath) is the folder into which the software was installed, which defaults to C:\My Documents\HVLwin84 for version 8.4. It is possible to move the database components to a different location, such as the data folders to a folder on a shared network drive (see HVLab Diagnostic Instruments Manager Database User Manual for further details).

(xv) Scroll down the Database Components window until you see the Available Tests and Health Surveillance Questionnaires table and make sure that the boxes in the Enabled column are checked for all the tests or questionnaires which you want to be available on your computer. An appropriate instrument should be selected in the Instrument column for each test that has been enabled. Make sure that the serial numbers of each instrument connected to your computer are entered in the Serial No. column. The Interface column should be set to MCC for each of these instruments. Tests for which you do not have the necessary instrument hardware connected can be run in simulation mode (check the boxes for these tests in the Simulation column) or they can be left unchecked.

(xvi) When you are satisfied that all the components are located correctly, click on ‘Save’. This will link the database program to the tables and open the main Control Panel window.

B.3 Performing an installation over a distributed network

(i) Before launching the database on any of the computers it is necessary to create a common database table on the network. On one computer only, locate the Data folder in the folder into which the HVLab Diagnostic Instruments Manager software was just installed. Copy this folder to a location on the network that can be accessed by all the test computers. Please note that all the computers which need to use the database over a network must have full-access rights to this location on the network.
(ii) Start the HVLab software on each computer by selecting HVLab Diagnostic Instruments from the Start/Programs menu or from the desktop. You will be required to enter a valid User ID and Password: the default Personal ID is “Admin” with Password “hvlab”. Additional users can be added or deleted after the software has been successfully set up (see HVLab Diagnostic Instruments Manager Database User Manual for further details).

(iii) The first time that the software is launched on each computer, the location of all the software components will be automatically detected and displayed in the Database Components window. The default location for the file containing the data tables - HVLab_di_tables.mdb - is (InstallPath)\Data where (InstallPath) is the folder into which the software was installed, which defaults to C:\My Documents\HVLwin84 for version 8.4. Use the browse button to the right of the displayed data path to find the copy of the data tables that have been moved to the network (see (ii), above). The five data folders for the individual test data should also be relocated to the data folder on the network (see HVLab Diagnostic Instruments Manager Database User Manual for further details).

(iv) Scroll down the Database Components window until you see the Available Tests and Health Surveillance Questionnaires table and make sure that the boxes in the Enabled column are checked for all the tests or questionnaires which you want to be available on your computer. An appropriate instrument should be selected in the Instrument column for each test that has been enabled. Make sure that the serial numbers of each instrument connected to your computer are entered in the Serial No. column. The Interface column should be set to MCC for each of these instruments. Tests for which you do not have the necessary instrument hardware connected can be run in simulation mode (check the boxes for these tests in the Simulation column) or they can be left unchecked.

(v) When you are satisfied that all the components, tests and boards have been specified correctly, click on ‘Save’. This will link the database program to the tables and open the main Control Panel window.
Annexe C: Guidance and manufacture’s declaration

C1. Guidance and manufacturer’s declaration – electromagnetic emissions

HVLab Thermal Aesthesiometer is intended for use in the electromagnetic environment specified below. The customer or the user of the model TA 2.1 should assure that it is used in such an environment.

<table>
<thead>
<tr>
<th>Emissions test</th>
<th>Compliance</th>
<th>Electromagnetic environment - guidance</th>
</tr>
</thead>
<tbody>
<tr>
<td>RF emissions CISPR 11</td>
<td>Group 1</td>
<td>The Thermal Aesthesiometer uses RF energy only for its internal function. Therefore, its RF emissions are very low and are not likely to cause any interference in nearby electronic equipment.</td>
</tr>
<tr>
<td>RF emissions CISPR 11</td>
<td>Class A</td>
<td>The Thermal Aesthesiometer is suitable for use in all establishments other than domestic and those directly connected to the public low-voltage power supply network that supplies buildings used for domestic purposes.</td>
</tr>
<tr>
<td>Harmonic emissions IEC 61000-3-2</td>
<td>Class A</td>
<td>Pass</td>
</tr>
<tr>
<td>Voltage fluctuations/ flicker emissions IEC 61000-3-3</td>
<td>European limits</td>
<td>Pass</td>
</tr>
</tbody>
</table>
C2. Guidance and manufacturer’s declaration – electromagnetic immunity

The Thermal Aesthesiometer is intended for use in the electromagnetic environment specified below. The customer or the user of the Thermal Aesthesiometer should assure that it is used in such an environment.

<table>
<thead>
<tr>
<th>IMMUNITY test</th>
<th>IEC 60601 TEST LEVEL</th>
<th>Compliance level</th>
<th>Electromagnetic environment – guidance</th>
</tr>
</thead>
</table>
| Conducted RF  | IEC 61000-4-6        | 3 Vrms           | Portable and mobile RF communications equipment should be used no closer to any part of the Thermal Aesthesiometer including cables, than the recommended separation distance calculated from the equation applicable to the frequency of the transmitter. Recommended separation distance: 
  \[ d = 1,2 \times P \]  
  where P is the maximum output power rating of the transmitter in watts (W) according to the transmitter manufacturer and d is the recommended separation distance in metres (m). Field strengths from fixed RF transmitters, as determined by an electromagnetic site survey, (a) should be less than the compliance level in each frequency range. (b) Interference may occur in the vicinity of equipment marked with the following symbol: 

<table>
<thead>
<tr>
<th>Radiated RF</th>
<th>IEC 61000-4-3</th>
<th>3 V/m</th>
<th>3 V/m</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td>80 MHz to 2,5 GHz</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>80 MHz to 800 MHz</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>3 V/m</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>3 V/m</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>3 V/m</td>
</tr>
</tbody>
</table>

NOTE 1 At 80 MHz and 800 MHz, the higher frequency range applies.
NOTE 2 These guidelines may not apply in all situations. Electromagnetic propagation is affected by absorption and reflection from structures, objects and people.

(a) Field strengths from fixed transmitters, such as base stations for radio (cellular/cordless) telephones and land mobile radios, amateur radio, AM and FM radio broadcast and TV broadcast cannot be predicted theoretically with accuracy. To assess the electromagnetic environment due to fixed RF transmitters, an electromagnetic site survey should be considered. If the measured field strength in the location in which the Thermal Aesthesiometer is used exceeds the applicable RF compliance level above, the Thermal Aesthesiometer should be observed to verify normal operation. If abnormal performance is observed, additional measures may be necessary, such as re-orienting or relocating the Thermal Aesthesiometer.
(b) Over the frequency range 150 kHz to 80 MHz, field strengths should be less than 3 V/m.
Guidance and manufacturer’s declaration – electromagnetic immunity

The Thermal Aesthesiometer is intended for use in the electromagnetic environment specified below. The customer or the user of the Thermal Aesthesiometer should assure that it is used in such an environment.

<table>
<thead>
<tr>
<th>IMMUNITY test</th>
<th>IEC 60601 test level</th>
<th>Compliance level</th>
<th>Electromagnetic environment – guidance</th>
</tr>
</thead>
<tbody>
<tr>
<td>Electrostatic discharge (ESD)</td>
<td>± 4 kV contact ± 8 kV air</td>
<td>± 4 kV contact ± 8 kV air</td>
<td>Floors should be wood, concrete or ceramic tile. If floors are covered with synthetic material, the relative humidity should be at least 30%.</td>
</tr>
<tr>
<td>IEC 61000-4-2</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Electrical fast transient/burst</td>
<td>± 2 kV for power supply lines ± 1 kV for input/output lines</td>
<td>± 2 kV for power supply lines ± 1 kV for input/output lines</td>
<td>Mains power quality should be that of a typical commercial or hospital environment.</td>
</tr>
<tr>
<td>IEC 61000-4-4</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Surge</td>
<td>± 1 kV line(s) to line(s) ± 2 kV line(s) to earth</td>
<td>± 1 kV differential mode ± 2 kV common mode</td>
<td>Mains power quality should be that of a typical commercial or hospital environment.</td>
</tr>
<tr>
<td>IEC 61000-4-5</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Voltage dips, short interruptions and voltage variations on power supply lines</td>
<td>&lt;5 % 240 (&gt;95 % dip in 240 ) for 0,5 cycle 40 % 240 (60 % dip in 240 ) for 5 cycles 70 % 240 (30 % dip in 240 ) for 25 cycles &lt;5 % 240 (&gt;95 % dip in 240 ) for 5 s</td>
<td>&lt;5 % 240 (&gt;95 % dip in 240 ) for 0,5 cycle 40 % 240 (60 % dip in 240 ) for 5 cycles 70 % 240 (30 % dip in 240 ) for 25 cycles &lt;5 % 240 (&gt;95 % dip in 240 ) for 250 cycles</td>
<td>Mains power quality should be that of a typical commercial or hospital environment. If the user of the Thermal Aesthesiometer requires continued operation during power mains interruptions, it is recommended that the Thermal Aesthesiometer be powered from an uninterruptible power supply.</td>
</tr>
<tr>
<td>IEC 61000-4-11</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Power frequency (50/60 Hz) magnetic field</td>
<td>3 A/m</td>
<td>3 A/m</td>
<td>If there is a reduction in delivery performance it may be necessary to position Thermal Aesthesiometer further from sources of power frequency magnetic fields or to install magnetic shielding. The power frequency magnetic field should be measured in the intended installation location to assure that it is sufficiently low.</td>
</tr>
<tr>
<td>IEC 61000-4-8</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

NOTE 240 is the a.c. mains voltage prior to application of the test level.